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Premiere Pro
Quickstart

Welcome to the world of Adobe Premiere Pro and digital
video. For both experts and beginners alike, Adobe
Premiere Pro packs the power you need to create sophisti-
cated digital video productions. You can create digital movies,
documentaries, sales presentations, and music videos directly
from your desktop computer or laptop. Your digital video pro-
duction can be output to videotape or the Web, or you can
integrate it into projects in other programs, such as Adobe
After Effects, Adobe Live Motion, Macromedia Director, and
Macromedia Flash.

This chapter introduces you to the basics of Adobe Premiere
Pro: understanding what it is and what you can do with it.
This chapter also provides a simple Quickstart project to get
you acquainted with the Adobe Premiere Production process.
You'll see how easy it is to load digital video clips and graph-
ics into an Adobe Premiere Project and edit them into a short
presentation. After you’ve completed the editing process,
you’ll export the movie as either a QuickTime or Windows
Media file for use in other programs.

What You Can Do with
Premiere Pro

Whether you need to create a simple video clip for the Web or
a sophisticated documentary or presentation, Premiere Pro has
the tools you need to create a dynamic video production. In
fact, the best way to think about Premiere Pro is to visualize it
as a complete production facility. You would need a room full
of videotape and special effects equipment to do everything
that Premiere Pro can do.
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Here’s a short list of some of the production tasks that you can accomplish with
Premiere Pro:

4+ Edit digital video clips into a complete digital video production.

4 Capture video from a digital camcorder or videotape recorder.

4 Capture audio from a microphone or audio recording device.

4 Load stock digital graphics, video, and audio clips.

4+ Create titles and animated title effects, such as scrolling or rolling titles.

4 Integrate files from different sources into your production. Premiere Pro
loads not only digital video and audio files, but also Adobe Photoshop,
Adobe Illustrator, JPEG, and TIFF graphics.

4+ Create special effects, such as distortions, blurring, and pinching.

4+ Create motion effects in which logos or graphics move or bounce across the
screen.

4+ Create transparency effects. You can superimpose titles over backgrounds or
use color, such as blue or green, to mask the background from one image so
that you can superimpose a new background.

4+ Edit sound. Premiere Pro enables you to cut and assemble audio clips as well
as create sophisticated audio effects, such as cross fades and pans.

4 Create transitions. Premiere Pro can create simple dissolves from one scene
to another, as well as a host of sophisticated transition effects, such as page
curls and curtain wipes.

4 Output files in a variety of digital formats. Premiere Pro can output QuickTime
and Video for Windows files, which can be viewed directly in other programs,
as well as streamed over the Web. Premiere Pro also features Web-specific file
formats, such as animated GIF.

4 Output files to videotape.

How Premiere Pro Works

To understand the Premiere Production process, you need a basic understanding
of the steps involved in creating a conventional videotape production in which the
production footage is not digitized. In traditional, or linear, video production, all
production elements are transferred to videotape. During the editing process, the
final production is electronically edited onto one final or program videotape. Even
though computers are used while editing, the linear or analog nature of videotape
makes the process very time-consuming; during the actual editing session, video-
tape must be loaded and unloaded from tape or cassette machines. Time is wasted
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as producers simply wait for videotape machines to reach the correct editing point.
The production is usually assembled sequentially. If you want to go back to a previ-
ous scene and replace it with one that is shorter or longer, all subsequent scenes
must be rerecorded to the program reel.

Nonlinear video-editing programs such as Premiere Pro have revolutionized the
entire process of video editing. Digital video and Premiere Pro eliminate many of
the time-consuming production chores of traditional editing. When using Premiere
Pro, you don’t need to hunt for tapes or load and remove them from tape machines.
When producers use Premiere Pro, all production elements are digitized to disk. An
icon in Premiere Pro’s Project window represents each element in a production,
whether it is a video clip, a sound clip, or a still image. The final production is rep-
resented by icons in a window called the Timeline. The focal points of the Timeline
are its video and audio tracks, which appear as parallel bars that stretch from left
to right across the Timeline. When you need to use a video clip, sound clip, or still
image, you simply click it in the Project window and drag it to a track in the Timeline
window. You can place the items of your production down sequentially or drag them
anywhere to different tracks. As you work, you can access any portion of your pro-
duction by clicking with the mouse in the desired portion in the Timeline window.
You can also use the mouse to click either the beginning or end of a clip and shorten
or extend the clip’s duration.

To fine-tune your edits, you can view and edit the clips frame by frame in the
Timeline window. You can also set in and out points in the Monitor window. Setting
an in point affects where a clip starts playing, and setting an out point affects where
a clip stops playing. Because all clips are digitized (and no videotape is involved),
Premiere Pro can quickly adjust the final production as you edit.

The following list summarizes some of the digital-editing magic that you can per-
form in Premiere Pro by simply dragging clips in the Timeline:

4 Rolling edit. As you click and drag to add frames to the clip in the Timeline,
Premiere Pro automatically subtracts from the frames in the next clip. As you
click and drag to remove frames, Premiere Pro automatically adds back frames
from the next clip in the Timeline.

4+ Ripple edit. As you add or subtract frames, Premiere Pro automatically adds
to or subtracts from the entire program’s duration.

4 Slip edit. Dragging a clip to the left or right automatically changes in and out
points without changing the program duration.

4 Slide edit. Dragging a clip to the left or right keeps its duration intact but
changes the in or out points of the preceding or succeeding clip.

r Cross- Chapters 7 and 13 both provide in-depth discussion of Premiere Pro editing
Reference’)  techniques.
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As you work, you can easily preview edits, special effects, and transitions. Changing
edits and effects is often a simple matter of changing in and out points. There’s no
hunting down the right videotape or waiting for the production to be reassembled
on tape. When all of your editing is completed, you can export the file to videotape
or create a new digital file in one of several formats. You can export it as many times
as you want, in as many different file formats as you want. Furthermore, if you want
to add more special effects to your Premiere Pro projects, you can easily import them
into Adobe After Effects. You can also integrate your Premiere Pro movie into a Web

page using Adobe GoLive.
r Cross- Adobe After Effects is covered in Chapters 26 and 30. Adobe Golive is discussed in
Reference Chapter 20.

Your First Video Production

The following sections provide a Quickstart tutorial that leads you step by step
through the basics of video production in Premiere Pro. As you work through the
tutorial, you’ll learn how to place clips in the Timeline, edit clips in the Monitor
window, apply transitions, and fade video and audio.

In this project, you’ll create a simple video sequence called Nite Out. Figure 1-1
shows frames of the production in Premiere Pro’s Timeline window. The clips used
to create the project are from Digital Vision’s Night Moves CD-ROM. The production
begins with a title created in Adobe Title Designer, viewed over an opening scene of
people walking in the city. After a few seconds, a dissolve transitions to the scene
of diners in a restaurant. Soon the dining scene dissolves into one showing kitchen
workers preparing food. The project ends with another title superimposed over the
last scene.

Starting a Premiere Pro project

A Premiere Pro digital video production is called a project instead of a video produc-
tion. The reason for this is that Premiere Pro not only enables you to create the pro-
duction, but it also enables you to create and store titles, transitions, and effects.

Thus, the file you work in is much more than just a production —it’s truly a project.

Your first step in creating a digital video production in Premiere Pro is to create a
new project. Here’s how:

1. To load Premiere Pro, double-click the Adobe Premiere Pro icon. When you
load Premiere Pro, the program automatically assumes that you want to create
a new project or open one previously created.

2. To create a new project, click the New Project icon. If Premiere Pro is already
loaded, you can create a new project by choosing File > New Project.

.
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Figure 1-1: Scenes from the Nite Out project.

ﬁlote If Premiere Pro is already loaded and you already have a project onscreen, you
~—~  need to close that project because you can only have one project open at a time.

.



03 542265 ch0l.gxd 11/20/03 10:18 AM Page 8 $

8 Part | 4 Getting Started with Premiere Pro

Specifying project settings

Before you can start importing files and editing, you must specify video and audio
settings for the project. The New Project dialog box, shown in Figure 1-2, appears
whenever you create a new project. This dialog box enables you to quickly choose
predetermined video and audio settings. The most important project settings deter-
mine the frame rate (frames per second) and the frame size (viewing area) of your
project as well as how the digital video will be compressed.

¢ Cross- For a detailed description of project settings, see Chapter 4.
Reference

New Project
Load Preset | Custom Settings
Available Presets
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B Standard 48z 32kHz (12/16 bit) audic.
- widescreen 32kHz Drop-Frame Timecode numbering.
B widescreen 48kHz
() ow-PaL
= 52 Non-Dv
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ter Screen NTSC
P Querter Scresn Editing mode: DV Playback =
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 Square-Pixel 640480 1
5 . Video Settings
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Frame rate: 23,97 frames/second
Pixel Aspect Ratio: D1/D¥ MTSC (0.9)
Colar depth: Millons of colrs =
Location: | C:{Premiere Projectsi vl

Figure 1-2: Use the New Project dialog box to pick
project presets.

As a general rule, choose project settings that match your source footage. The
footage used for this tutorial conforms to a video standard called NTSC D1. The
frame size is 720 by 486. The audio file is 16-bit 44 kHz.

1. To work with the tutorial footage, choose the DV NTSC Standard 32 kHz.
After you click, Premiere Pro displays information about the project settings.

Notice that the Frame Size is 720 by 480, the standard DV frame size (which is
close enough to our 720 by 480 footage. Also note that under Video Settings,
the display reads D1/DV Pixel Aspect Ratio (0.9). This indicates that you are
creating a project for footage with non-square pixels. Since the tutorial footage
uses non-square pixels, this is the correct choice for the project. However, since
the tutorial audio is 44 kHz (better quality than 32 kHz, you need to change
one of the audio presets.

2. To change a preset, click the Custom Settings tab.

3. In the Audio section of the dialog box, click the Sample Rate pop-up menu
and choose 44 kHz.

.
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Audio Samples are discussed in Chapter 8.

w To learn more about Pixel Aspect Ratio and choosing project settings see Chapter 4.
ererence

4. Select a location to store your file. If you want to change the default location,
click Browse and use the mouse to navigate to the folder where you want to
store your file.

5. Enter a name such as Nite Out in the name field.

6. To open your new project, click OK.

Setting a workspace

Before you start editing, you may want to set your workspace so that you can easily
view the most important Premiere Pro windows used in editing. This is easily accom-
plished by picking an editing workspace. Choose Window => Workspace => Editing.
This opens the Project, Monitor, and Timeline windows as well as the Info and
History palettes. In this tutorial, you use the Project window as your home for source
footage. You'll edit your clips in the Timeline and Monitor window, and you’ll view
the edited project in the Monitor window.

If the Timeline doesn’t open, double-click Sequence 01 in the Project window. The
~—  sequence will open onscreen in the Timeline window.

Importing production elements

You can place and edit video, audio, and still images in your Premiere Pro projects
as long as they are in a digital format. Table 1-1 lists the major file formats that
Premiere Pro supports. All media footage, or clips, must first be saved to disk. Even
if your video is stored on a digital camcorder, it still must be transferred to disk.
Premiere Pro can capture the digital video clips and automatically store them in
your projects. Analog media such as motion picture film and videotape must first
be digitized before Premiere Pro can use it. In this case, Premiere Pro, in conjunc-
tion with a capture board, can capture your clips directly into a project.

¢ Cross- For more information about capturing video and audio, see Chapter 5.
Reference

Table 1-1
Supported Files in Adobe Premiere Pro
Media File Formats
Video QuickTime (MOV) and Video for Windows (AVI)
Audio AIFF WAV, AVI, and MOV

Still images, and Sequence TIF, JPEG, BMP (Windows only), GIF, Filmstrip, Illustrator,
and Photoshop

.
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After the Premiere Pro windows open, you're ready to import the various graphic
and sound elements that will comprise your digital video production. All the items
that you import are stored in the Project window. An icon represents each item.
Next to the icon, Premiere Pro displays whether the item is a video clip, an audio
clip, or a graphic.

When importing files into Premiere Pro, you can choose whether to import one file,
multiple files (by pressing and holding the Shift key), or an entire folder. If desired,
you can even import one project into another, using the File ™ Import = Project
command.

Here’s how to load the production elements for the Nite Out project:

1. Choose File => Import.

2. Open the Tutorial Projects folder on the Adobe Premiere Pro Bible
DVD-ROM.

3. If you want to load the files, select the Nite Out folder in the Chapter 1 folder
and then click Import Folder. The Nite Out folder now appears in the Project
window.

EDV \\ The video clips (705008f.mov, 705009f.mov and 705029f.mov) used in the Nite
\ / Out project are from Digital Vision’s NightMoves CD. The sound clip (705001.aif)
“.  used in the Nite Out project is also from Digital Vision’s NightMoves CD. The Nite
Out folder is in the Chapter 1 folder in the Tutorial Projects folder on the DVD that
accompanies this book.

4. To view the titles, and video and audio clips, double-click the Nite Out
folder in the Project window.

5. Rename each clip. Because the names of imported clips may not clearly
describe their footage, you can rename them in the Project window. To rename
a clip, click on it in the Project window and choose Clip=> Rename. (As a
shortcut, you can also right-click the clip and then rename it.) Here are the file-
names and the new names to use:

e Name the 705001.aif audio clip: Background Music.
e Name the 705008f clip: Diners.
e Name the 705009f clip: Chefs.
e Name the 705029f clip: Walkers.
Figure 1-3 shows the Project window with all the clips needed to create the Nite Out

project clip. Notice that the Project window displays the Start and Stop time of each
clip as well as its duration.
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Figure 1-3: The Project window with the items needed to
create the Nite Out project.

The Nite Out project requires the following files:

4+ A video clip showing shadows of people walking in the city (Walkers)
4+ A video clip of people out in a restaurant (Diners)
4 Avideo clip of chefs working in a restaurant (Chefs)

4+ Two title files created using templates from Adobe Title Designer

4+ A sound clip of background music

'Alﬂte The video footage was captured at 30 frames per second. Although not necessary
~  for this tutorial, you could change the footage frame rate to the Project frame rate

by selecting the footage in the Project window and choosing File = Interpret

Footage. In the Interpret Footage dialog box, you can enter a new frame rate for

the footage.

r Cross- Creating titles in Premiere Pro is discussed in Chapter 11.
Reference

Viewing clips in the Project window

Before you begin assembling your production, you may want to view a clip or
graphic, or listen to an audio track. You can see a thumbnail preview of any of the
clips in the Project window by clicking the clip. The preview appears at the upper-
left corner of the Project window. If you are previewing a video or audio clip, a small
triangle (Play button) appears to the left of the thumbnail preview window. Click
the Play button to see a preview of a video clip or to hear an audio clip. If you pre-
fer, you can click and drag the tiny slider below the thumbnail preview to gradually

view the clip.

11
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,J‘\Iote Double-clicking the clip in the Project window opens the clip in the Monitor win-
~~  dow. You can preview the clip there by clicking the Play button.

Assembling production elements

After you import all of your production elements, you need to place them in a
sequence in the Timeline window so that you can start editing your project.

A sequence is a graphical preview of the footage that you are editing. Using the
mouse, you can place, edit, rearrange, and create transitions in the Timeline win-
dow sequence.

Alote If you are working on long projects in Premiere Pro, you'll probably want to break
~—~  your work into multiple sequences. After you've edited the sequences, you can
drag them into another Timeline window where they'll appear as nested

sequences. Using nested sequences is discussed in Chapter 6.

Placing clips in the Timeline

To move an item from the Project window to the Timeline window, simply click it in
the Project window and then drag it to a track in the Timeline window. The item then
appears in the Timeline as an icon. The duration of the clip or graphic is represented
by the length of the clip in the Timeline.

ﬁlote You can place clips directly in the Timeline by opening them in the Monitor window,
~  then clicking the Insert or Overlay button. This technique is discussed in Chapter 7.

Selecting clips in the Timeline

You'll spend a great deal of time positioning clips in the Timeline while editing your
production. Premiere Pro’s Selection and Range Select tools help you assemble
your program’s clips in the order you want.

Here’s how to select and move clips:

4 Single clip. Click the Selection tool (the arrow icon in the upper-left corner
of the Timeline). Next, click in the middle of the clip in the Timeline window.
(To quickly activate the Selection tool, press V on your keyboard.) With the
clip selected, click and drag it to the desired location.

4 Multiple clips. Click the Range Select tool (the empty dotted-line square icon
in the toolbox located to the right of the Selection tool). Next, click and drag
over the clips that you want to select. To select the Range Select tool using
your keyboard, press M.

Figure 1-4 displays the Timeline window for the Nite Out project. The title appears
in the Video 2 track. We put it here because it enables us to create a transparency
effect in which we fade in the title text over background video. The Walkers video
clip appears in track Video 1, as does the next clip (the Diners clip). Between the two

.
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tracks is a transition. In this case, we dragged a dissolve from the Effects window.
The project also ends with a transition to a scene of chefs working in a kitchen,
before the final title appears and then fades out.

Show keyframes

Current time Current-time indicator
Expand track Work area bar
o Timgline 9] % |
l Sdqudnce 01 = WU 5|
00:00:04:00 D o0, 200
‘E‘-‘ IR W I WA I

£ 3l

| 4
Zoom slider Show keyframes

Zoomout  Zoomin

Set Display style

Figure 1-4: The Timeline window with the clips for the
Nite Out video project.

Trying out the Timeline window

As mentioned earlier, the Timeline window provides a graphical overview of your
project. Before continuing, try changing zoom settings, moving the Timeline indica-
tor, and expanding a video track. Doing so will help familiarize you with the Timeline
tools you need as you work in this chapter.

Changing the zoom level

Most Premiere Pro users create their video projects at 29.97 or 30 frames per sec-
ond. Viewing all of these frames on the Timeline quickly consumes Timeline space.
As you work, you’ll probably want to zoom in and out between close-up and bird’s-
eye views of your work. When you zoom in, you’ll see fewer frames, which may make
fine-tuning your project easier, particularly because the space between time intervals
in the Timeline expands. When you want an overview of your entire project, you may
want to zoom out.

13
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To zoom in and out, click the Timeline zoom level slider in the lower-left corner of
the Timeline. Figure 1-4 shows the Timeline zoom slider as well as the zoom in and
zoom out buttons. Clicking and dragging left (zooming out) shows more footage in
the Timeline; clicking and dragging to the right (zooming in) shows less footage.

For example, if you zoom out, a one-minute clip will take up less space in the
Timeline — which means you’ll be able to see many different clips as well as your
one-minute clip. If you zoom in a one-minute clip will occupy more space in the
Timeline, which means that it may be the only clip visible.

Moving the current-time indicator

The current-time indicator (sometimes referred to as CTI) is the blue triangular icon
at the tip of the ruler area in the Timeline. If you click and drag the current current-
time indicator, you move the red edit line. The edit line shows you the current editing
position in the Monitor window. Try clicking and dragging the current current-time
indicator. Notice that as you drag the blue current time readout changes, showing
your current position in the Timeline. In Figure 1-4, the edit line is on the 4-second
mark on the Timeline, and the current time reads 00;00;04;00. If you want to quickly
jump to an area in the Timeline, just click in the ruler area. If you want to slowly
move through the Timeline one frame at a time, press the right or left arrow keys.

Expanding tracks

By default, you'll see three video tracks in the Timeline. If you expand a track, you
can see video frames in the track and video effects. Later, you’ll change the display
style to show frames in the video tracks, and volume in audio tracks. The white dots
in the audio and video tracks in Figure 1-4 are keyframes, which indicate a change
in volume or opacity. By default, Video track 1 and Audio track 1 are expanded. In
this project, you will also be using Video track 2. Try expanding it now by clicking
the right-pointing triangle to the left of Video track 2.

Adding the title to the Timeline

Start the production process by adding the opening title to the Timeline. The title
includes an alpha channel, which allows the background video to be seen beneath the
title. The title was created from a template in Premiere Pro’s Title Designer. In this
section, you’ll place the title in the Video 2 track because it enables you to easily
fade in the text over the video in lower tracks.

g See Chapter 11 to learn more about Adobe Title Designer.
Reference

The following steps explain how to add the title to the Timeline window, fading it in
and out:
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1. Click the Nite Out title (TitleOpen) in the Project window and drag it into
Video track 2.

2. If you would like the clip to appear longer in the Timeline, zoom in by
clicking and dragging the zoom slider to the right.

3. Now view the footage as individual frames in the Timeline. In Video track 2,
click the Set Display Style drop-down menu and choose Show Frames. (This
drop-down menu is a tiny box directly below the Eye icon in the track.)

4. Reduce the length of the title to 4 seconds by clicking and dragging left on

the right end of the title. Use the time readout at the top of the Timeline as a
guide.

Here's a technique that will allow you to work more precisely in the Timeline. Click
_»  and drag the current-time indicator to the 4-second mark. Then use the red edit
line as a stopping point when you click and drag on the end of the title clip.

Fading in the title

Next, you’ll fade in the titles. In Figure 1-4, the diagonal line immediately in the track
represents the fade-in effect. The diagonal line indicates that the title fades in grad-
ually over the first second. In this section, you’ll create the fade-in effect by chang-
ing the opacity of the title clip in the Effects Control window. Figure 1-5 shows the
Effect Controls window and the Opacity slider. The diamonds on the right side of the
window are called keyframes. Each time you make a change in the Opacity setting,
Premiere Pro creates a keyframe; then Premiere Pro adjusts the opacity between
the keyframes to gradually change.

o Effect Controls ==
Effect Controls x o |

Sequence 01 % TitleOpenprtl %) {o0;00 00:00;02,00 00; 0!

Fixed Effects (%) | TitleCpen.pril

@ » [k Motion (<}

@ v Opacity r

o [ B Opacity 00 % NS
L1 1000 <& <@

VIO =5 = = >

Add/Remove keyframe

Figure 1-5: Use the Opacity slider to create keyframes,
which create a gradual fade-in effect.

15
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/Alote

Tip

The following steps show you how to change opacity.

N

1.

Display the Opacity handles in the track. Click in the Show Keyframes drop-
down menu (the tiny box to the right of the Set Display Style drop-down menu)
and choose Show Opacity Handles.

2. Select the TitleOpen file in the Timeline by clicking it.

3. Open the Effect Controls window by choosing Window = Effect Controls.

Before continuing, note that the Effect Controls window includes a Zoom slider
in the lower left and a current-time indicator. Both function exactly as they
do in the Timeline window.

. Now expand the Opacity control by clicking the right-pointing triangle but-

ton (to the left of the word Opacity). The Opacity control expands. You can
easily change opacity by clicking and dragging the Opacity slider. To view the
slider, click the right-pointing arrow button to the left of the stopwatch in the
Opacity section.

. Lower the opacity to 0. To lower opacity, click and drag left until the display

reads 0%, as shown in Figure 1-5.

. Now drag the current-time indicator in the Effect Controls window to the

1-second mark. As you click and drag, you'll see the time display change in
the lower-left corner. Stop when you reach 1 second.

. Now raise the opacity back to 100 percent. Click and drag the slider to the

right. As you drag, the percentage begins to increase.

. The change in opacity created two keyframes, one at the start of the clip and

another one second later. Between the two keyframes, Premiere Pro adjusts
opacity to gradually increase from 0 to 100 percent

. Now create a fade out at the 3-second mark. Click and drag the current-time

indicator to the 3-second mark, then click the Add/Remove Keyframe button.
Then drag the Timeline indicator slider to the 4-second mark. Click and drag
the Opacity slider to set it to 0%. After you make the change, Premiere Pro
adds another keyframe to the window. When you’re done, the Effect Controls
window should resemble Figure 1-5.

You can also change video opacity directly in the Timeline with the Pen tool.
Control+clicking on the Opacity rubberband in the Timeline creates keyframes.
After you create keyframes, you can adjust opacity by clicking and dragging with
the Pen tool.

If you need to delete a keyframe, right-click it and choose Clear.
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Trimming clips in the Timeline window

You can edit video and audio clips in several ways. We’ll start simply by editing the
first clip by clicking and dragging its out point in the Timeline. Before editing a clip,
you may want to play it in the Monitor window. To play any clip, double-click the
video clip in the Project window. When the Monitor window appears, click the Play
button to view the clip. The Play button is shown in Figure 1-6.

P Monitor ot
= Saquence 1 : Walkers : D0;00;00:23 X C

A'NITEOUT
ON THELOWN

+00,0003:14 i 00;00:04;01 1+ | 900;00;01:24 - 00;00;13;29 1+

) —
00 94 ﬂn,nn,lns,nn ‘ A 00;0416,08 00;08,32:16

EI S R T L - ) T S R T A A )
i v rrre—n ok B e Errrre—n—Tn
Play
Play In to Out

Figure 1-6: The Monitor window’s Play button.

The following steps explain how to add the first video clip, the Walkers clip, to the
Timeline window. If you haven’t viewed the clip, you can play it by double-clicking
it in the Project window, then clicking the Play button in the Monitor window.
Alternatively, you can play a thumbnail version of it in the Project window. Click it
in the Project window and then click the left arrow button at the top of the Project
window. Also note that the clip is 14 seconds long. You only need the first 4 seconds
of it.

1. Drag the Walkers clip from the Project window into the Video 1 track.
Position the clip so that it starts where the title fade-in ends —about 1 second
on the Timeline. If you want to be precise, drag the Timeline indicator to the
1-second mark and then drag the Walkers clip to the current-time indicator
edit line. When the clip touches the edit line, it will snap to it.

2. Position the mouse pointer at the end of the clip. The cursor changes to a
bracket.

17
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3. Click and drag to the left to shorten the clip. Make the clip about 4 seconds
long so that it ends on the 5-second mark (00;00;05;00) on the Timeline. Once
again, you may want to drag the current-time indicator to the 5-second mark
first and then adjust the clip by clicking and dragging the right edge of the clip
so it snaps on the edit line.

Tip If you get lost in the Timeline and inadvertently move out of the edited area, zoom
_»_outso that you can see the clips you've placed in the Timeline, move the current-
7 time indicator into the edited area, and then zoom in.

Previewing in the Monitor window

To view the video production so far, you can play the program in the Monitor win-
dow. Make sure that the Monitor window is open by choosing Window = Monitor.
The right side of the Monitor window displays the program being edited in the cur-
rent sequence in the Timeline window, as shown in Figure 1-6. The left side shows
source clips. To play from the beginning to the end of your project, click the Play In
to Out button at the bottom of the right side of the Monitor window.

As soon as you click, the video clip rewinds and begins playing in the window. As it
plays you'll see the clip fade in, and you’ll see the Walkers clip superimposed beneath
the opening title. The Walkers clip appears only in the black area of the Title clip.

Editing in the Monitor window

The Monitor window provides precise controls for editing clips. Using the Monitor
window, you can easily navigate to specific frames and then mark in or out points.
After you set the in and out points, you can drag the clip directly to the Timeline.
Now you’ll set the in and out points in the Monitor window. To learn about the dif-
ferent ways to edit a video clip, see Chapters 7 and 13.

,J‘\Iote You can also click the Insert or Overlay button in the Monitor window to place a
= dip in the Timeline. This technique is described in Chapter 7.

Alote By default, Premiere Pro automatically snaps two adjacent clips together. You can
turn snap on or off by clicking the Magnet icon in the Timeline window.

1. Double-click the clip in the Project window. This opens the clip in the left side
of the Monitor window, shown in Figure 1-7. The left side of the window shows
source clips, and the right side of the window shows the edited sequence in the
Timeline window. If the current-time indicator is on the Walkers clip, you’ll see
it in the Sequence section of the Monitor window.

2. Play the clip by clicking the Play button in the left side of the Monitor win-
dow. The scene eventually shows a waitress handing out menus. Before you
edit the clip’s in and out points, you need to go to the precise frame that you
want to edit.
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Figure 1-7: You can use the Monitor window to edit clips.

3. Before editing the clip, you can jump back to its first frame by clicking the
Go to In Point button.

4. Now you want to be able to slowly move through the clip to set the in point.
Here are several options:

e Click the current-time indicator in the Monitor window and drag. As you
drag, you’ll move or scrub through the clip frame by frame.

e Click and drag in the jog tread at the bottom of the Monitor window. As
you click and drag, you’ll move through the clip frame by frame.

e Click and hold down the shuttle control to move in slow or fast motion.
Speed is controlled by how far left or right you move the shuttle. Moving
right moves forward through the clip. Dragging the shuttle to the left
moves backward.

e Click the Step back or Step forward button to move one frame at a time
forward or backward.

5. Now click and drag the jog icon to the right or drag the current-time indica-

tor in the Monitor window to the right. After about 6 seconds, the scene
switches to a long shot of the waitress handing out menus.

19
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6. Either by clicking and dragging or by entering the precise location into the
Time display using your keyboard, position the current-time indicator at
00;00;06;00.

7. Click the Set Out Point button (refer to Figure 1-7).

/‘\lote To clear an in or out point, press Alt, while clicking the in or out point button.
/

8. Now drag the clip to the Timeline so that it snaps to the Walkers clip.

Alote Although you edited the clip, the original clip on your hard disk is untouched. At
~~  any point in time, you can reedit the clip to return the missing parts.

Creating a transition

Now view your production by previewing it in the Monitor window. To start the
preview from the beginning of the Timeline, click the Play In to Out button in the
Sequence section of the Monitor window. As you watch the preview, notice that the
cut from the Walkers clip to the Diners clip is quite abrupt. To smooth the flow of
the production, you’ll add a transition between the two clips.

r Cross- For more information on using transitions, turn to Chapter 10.
Reference

Here’s how to add a Cross Dissolve transition to your project:

1. Open the Effects window by choosing Window => Show Effects palette,
if it is not already open.

2. In the Effects palette, open the Video Transitions folder by clicking its
triangle icon.

3. Open the Dissolve folder by clicking its triangle icon.

4. To add the transition to your project, click and drag it to beginning of the
Diners clip or between the Walkers and the Diners clip.

5. To open the window for the Cross Dissolve, double-click the Cross Dissolve
icon in the Timeline. This opens the transition in the Effect Controls window.

6. Adjust the position and length of the transition. You can adjust the position
and the duration of the transition by clicking and dragging the mouse on the
transition icon in the Effect Controls window. However, the fastest technique
is to enter a value in the Duration readout and change settings in the Alignment
drop-down menu. Set the Duration to 2 seconds by changing the time readout
to 00;00;02;00. Then choose Center at Cut in the Alignment drop-down menu,
as shown in Figure 1-8.
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Figure 1-8: The Cross Dissolve transition in the
Effect Controls window.

7. View a thumbnail preview. Preview the final transition by clicking the play
transition button in the Effect Controls window. To see the effect with the
footage, select Show Actual Sources.

Previewing the transition

Premiere Pro includes a real-time preview feature that enables you to view transi-
tions and video effects as you work. Press the spacebar to play the project and
show transitions.

Editing the Chefs clip
Next, you’ll add the Chefs clip to the program and edit it in the Monitor window:

1. Double-click the Chefs clip in the Project window. This opens the clip in the
source section of the Monitor window.

2. Set the in point. Click and drag the current-time indicator in the Monitor win-
dow (in the area below the Monitor preview and above the Play button) to
choose a frame at about a little more than 3 seconds into the clip. Click the
Set In Point button.

3. Set the out point. Click and drag the Monitor window’s current-time indicator
to find a point about 6 and ¥ seconds into the clip. Watch the time display at
the bottom-right of the window to pick the frame. When you have found the
frame you want, click the Set Out Point button.

4. After you’ve set the in and out points, you can drag the clip from either the
Project window or you can drag it directly from the Timeline.
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Adding another dissolve
Now create another transition — this time between the Diners clip and the Chefs clip:

1. Open the Dissolve folder in the Effects window.
2. Drag the Cross Dissolve transition over the Chefs clip.

3. Double-click the transition icon between the Diners and Chefs clips in the
Timeline.

4. In the Effect Controls window, set the Alignment pop-up menu to Center of
Cut. If you want to change the duration of the transition, edit the Duration time
display.

Adding the last title
Your next step is to add the end title to the Video 2 track:

1. Drag the end title image (Title End) from the Project window to the Video 2
track. Position the title clip so that it begins where the Chefs clip starts.

2. Drag the clip’s end point to make its duration 3 seconds long or select the
title and choose Clip => Speed/Duration. In the Clip Speed Duration dialog
box, set the display to 00;00;03;00 and click OK.

3. Create the fade in and fade out as you did for the opening title. Remember
to select the clip in the Timeline, then open the Effect Controls window by
choosing Window = Effect Controls. Use Figure 1-4 as a reference.

4. Preview your work, by pressing Spacebar.

Adding and fading in the audio track

Now that the majority of editing is complete, it’s time to add the audio track.
Fortunately, the Timeline treats audio much the same as it treats video. In this
section, you drag the music track to the Timeline, then use the Pen tool to create
a keyframe in the audio channel.

1. Listen to the Background Music clip by double-clicking it in the Project
window. After the clip opens in the Monitor window, click the Play button.

2. Drag the Background Music clip from the Project window to the Audio 1
track in the Timeline window. Line up the beginning of the audio track with
the beginning of the video track.

3. Expand the Audio 1 track by clicking the triangle icon at the far left of the
track.

4. Click the Audio track’s Show keyframes drop down menu and choose Show
Clip Volume.

5. Activate the Pen tool in the tool palette.

.
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6. With the Pen tool activated, Ctrl+click at the beginning of the audio to create
keyframe.

7. Create another keyframe about 2 seconds into the track by Ctrl+clicking
again with the Pen tool.

8. Use the Pen tool to drag down the start of the volume line.

9. Use the Pen tool to create a keyframe at the end of the audio. About 1 second
from the end, use the Pen tool to drag the volume line down to fade out.

10. Preview your project to see the production and hear the fade out. If you
want to fine-tune the effect, use the Pen tool to adjust the volume line in the
audio track.

Audio fade-ins can also be created by using the Crossfade audio transition. See

~  Chapter 8 to learn more about audio effects. Also note that Premiere Pro allows

you to change the volume of the entire audio track as well as individual clips.

Fine-tuning the project

The project you’'ve worked on is a simple introduction to editing in Premiere Pro.
Feel free to enhance, change, and re-edit as you desire. If you want, create a fade up
from black or fade out to black. You can create pure black video and place it in a
video track. To create black, choose File = New = Black Video. This command
places the black video clip into the Project window. From there, you can drag it into
the Timeline. If you want to fade in or out, place the clip in Video track 2. You might
also want to add a fade out to the Chefs clip. You can easily do so by selecting the
clip and changing the opacity of the last second of the clip.

Exporting your first movie

When you finish editing your movie, you can export it in a variety of different
formats. Premiere Pro enables you to export movies in video formats such as
QuickTime, RealVideo, and Advanced Windows Media, as well as formats for DVDs.

Here is a summary of Premiere Pro’s export commands:

4 If you want to export your file in a format for Web or DVD use, you can use
Premiere Pro’s Adobe Media Encoder. The Media Encoder allows you to
create MPEG, Windows Media, Real Video, and QuickTime streaming files.

4 If you want to export your movie as an AVI, QuickTime, or animated GIF file,
choose File @ Export Movie.

4+ If you want to export your movie to videotape, choose File > Export to Tape.
The following section shows how to export a Windows Media file using the Adobe

Media Encoder. A later section shows you how to export your project as a QuickTime
movie.

.
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Exporting a Windows Media file

If you are a Windows user, you may want to export your project in Windows Media
format. This format can be read by most Windows users, and can be used for projects
that appear on the Web. To export your movie in Windows Media format, follow these
steps:

1. Choose File = Export~> Adobe Media Encoder. The Transcode Settings dialog
box appears (see Figure 1-9).

2. In the Format pop-up menu, choose Windows Media.

3. Click a preset. For example, if you want to export your file for multiple Web
audiences and want to export your file for users with a high-speed Internet
connection, you could choose WMA9 NTSC512. The summary information
displays frame height, frame rate, and other exporting details. To continue
with the export, click OK.

4. Select a destination folder in which to store the finished Windows Media file,
and enter a filename. In the Destination section, click the button with three
dots on it. This opens the Save As dialog box where you can navigate to the
folder area where you want to save your file.

5. In the Export range drop-down menu, choose Entire Sequence, if it isn’t
already chosen.

6. To start the export, click Save.

" Transcode Settings

Fomat:— Windows Media v

Proset | 'wM3 NTSC 512K davnload ~] A=

Commert;

Summary
General
¥ Video
¥ tudio
¥ Metadata
Add/Femove Fields
Clea Fields
¥ fudiences
Add/Femove Audiences
Braadband or cable moden/DSL

< ul >

General Summary:
Output: Compressed
hverage Kbps: Variable

Video Summary:
Codec: Windows Media Video 3
Encoding Passes: Two

Etiate Mode: Yariable inconstiained
Allow interlaced processing: Off

Audio Summary:

Codec: Windows Media Audio 3
Encoding Passes: Two

Bitiate Mode: Yariable ncenstiained

Metadata Summary:

Summary:

Broadband or cable modem/DSL (768 Kbps)
Decoder Complesily: Aulo

width: 320

Height: 240

Frames Per Second: 30,00 [medium quality)
Keylrame Interval [seconds) 5

Euffer Size [seconds): Defaul

Average Video Bitrate: 448,00 low qualiy)

Audio Format: 54 kbps. 44 kHz, stereo VER

Figure 1-9: Use the Adobe Media Encoder to create a
Windows Media file for the Web.

.
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A note about rendering and playback quality

As Premiere Pro plays your program in the Monitor window, it attempts to adjust the out-
put to deliver the highest quality possible. If possible, it tries to play back at the project’s full
frame rate. If a portion of your program cannot be properly displayed, a red preview bar
appears onscreen. This indicates that the area must be rendered to disk. After rendering,
Premiere Pro uses the rendered disk file to properly display the effect. If you want to render
your entire project, press Enter. If you want to render only a portion of your project, first
adjust the work area bar so that it only encompasses the area that you want to render, then
press Enter. If you want to lower the processing requirements so that you can see effects at
a lower quality setting without rendering, you can change to Draft Quality in the Monitor
pop-up menu.

It's also important to note that despite the Quality Setting in the Monitor window, playback
quality in the Monitor window will not be as high as that of exported video. When Premiere
Pro processes video in the Monitor window, it uses bilinear pixel resampling. When
Premiere Pro exports, it uses cubic resampling, a higher quality method that also produces
higher quality sound.

Exporting a QuickTime movie

Both Mac and Windows users can export Premiere Pro projects as QuickTime
movies. QuickTime is widely used on the Web and can be imported into other pro-
grams such as Macromedia Director and Macromedia Flash. Depending on the final
destination of your project, you may want to change the frame size and frame rate
of your video before exporting. For example, if you want to export a file composed
of DV footage to a multimedia project, you’ll probably want to reduce the DV frame
size from 720 x 480 to a smaller size that fits comfortably into your production.

Here are the steps for exporting your project as a QuickTime movie:

1. Select the Timeline window, or select the Sequence 01 in the Project window.
2. Choose File => Export > Movie. The Export Movie dialog box appears.

3. Click the Settings button. The Export Movie Settings dialog box appears, in
which you can view export settings.

4. Choose QuickTime from the File Type drop-down list, as shown in Figure 1-10.

5. To switch frame size and frame rate, choose Video from the list box at the
upper-left of the dialog box. The Video Settings dialog box appears. These
settings are covered in detail in Chapter 4.

6. If you are creating a multimedia project that will play on a computer, select
either Sorenson or Cinepak as the compressor. Optionally, you can change
the frame size to 320 x 240 and change the frame rate, if desired. If you will be
outputting the file for computers with older CD-ROM drives, you need to lower
the data rate to about 250 Kbps. Doing so slows the data rate to prevent frames
from being dropped during playback.

.
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7. After you make your changes, click OK. Premiere Pro returns you to the
Export Movie dialog box.

8. In the Export Movie dialog box, type a name for your file.

9. Click OK. Premiere Pro builds the export file and soon opens it in the Monitor
window for viewing.

Export Movie Settings

General General

ideo .
Keplrame and Fiendeiing File Type: | QuickTime -
Audio afindows Bitmap

Range: |Fimstrip
arimated GIF

Compuserve GIF en Finished
DuickTime

Targa ed

TIFF
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Figure 1-10: Choose QuickTime in the File Type
drop-down menu.

Summary

This chapter gave you a chance to experiment with the basic concepts of editing
in Premiere Pro. You learned how to do the following:

4 Create a project.

4 Add clips to the Timeline.

4 Edit clips in the Monitor window and in the Timeline.

4 Change clip opacity.

4 Create transitions.

4 Preview your production.

4 Fade in and out audio.

4+ Export your production.



